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SYSTEMAND METHOD FORLINKING 
STREAMS OF MULTIMEDIA DATA TO 
REFERENCE MATERAL FOR DISPLAY 

Matter enclosed in heavy brackets appears in the 
original patent but forms no part of this reissue specifica 
tion; matter printed in italics indicates the additions 
made by reissue. 

Note: More than one reissue patent application has been 
filed for the reissue of U.S. Pat. No. 5,822,720. The reissue 
patent applications are U.S. Reissue patent application Ser: 
No. 1 1/064,519, filed Feb. 24, 2005, now U.S. Reissue Pat. No. 
Re. 40,731, U.S. Reissue patent application Ser: No. 1 2/480, 
556, filed Jun. 8, 2009, now U.S. Reissue Pat. No. Re 43,633, 
and the present U.S. Reissue patent application Ser: No. 
13/603,315, filed Sep. 4, 2012, which is a continuation reissue 
application of U.S. Reissue patent application Ser: No. 
1 2/480,556. 

This is a continuation of application Ser. No. 08/197,157 
filed Feb. 16, 1994 now abandoned. 

BACKGROUND OF THE INVENTION 

1. Technical Field 
The present invention relates to indexing displayed ele 

ments. More particularly, the present invention relates to a 
novel indexing scheme that is useful in Such applications as 
learning a foreign language, for example a language based 
upon an ideographic alphabet, such as Japanese. 

2. Description of the Prior Art 
As the global economy turns the world’s many nations into 

what media visionary Marshall McLuhan referred to as a 
global village, the need to learn and use new or specialized 
information, such as a language other than one's native lan 
guage, becomes increasingly important. For example, there is 
a tremendous international demand for information related to 
Japan. Inside Japan, there is an abundance of information 
available in the Japanese language in numerous media forms. 
Japan has five national newspapers, seven major broadcasting 
networks, and several hundred book and magazine publish 
ers. Japanese television focuses on the most obscure topics; 
and there are special interest magazines covering the full 
spectrum of Japanese Society. Speakers of the Japanese lan 
guage can find information on just about any topic imagin 
able. Unfortunately, outside of Japan this information is in 
short Supply and the information that is available is primarily 
in English. 

Individuals trying to learn about Japan are faced with the 
dilemma of either relying on English language sources or 
going through the pains of learning Japanese. English lan 
guage information on Japan must go through the translation 
process. This results in time delays in obtaining necessary 
information, as well as in distortions in meaning. Further 
more, economics itself places restrictions on what informa 
tion makes its way into English and what information does 
not. For general and introductory information on Japan, the 
English-based media is providing a valuable service. But for 
people who want to do more than scratch the Surface. Such 
information is far from sufficient. 
A large number of non-native speakers have sought to 

study Japanese in universities or in professional language 
Schools. In recent years, the interest level in Japanese among 
first year level college students has soared. Such that it is rated 
second only to Spanish in Some Surveys. The number of 
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2 
people studying Japanese in the mid-1980s in the United 
States was 50,000. This number has recently grown to 400, 
000 persons. But the study of Japanese language is plagued by 
the burdens of learning Kanji, the ideographic alphabet in 
which Japanese is written. Thus, the standing room only 
first-year Japanese language class in many universities soon 
becomes the almost private lesson-like third year class due to 
student attrition resulting from the difficulty of mastering 
Kanji. 
The situation in Japan for foreigners is not much more 

encouraging. The cost of living in Japan poses a major barrier 
for both business people and students. There are currently 
over 300,000 United States citizens working or studying in 
Japan. But in recent years, foreign companies have been 
cutting their foreign staff. This, in part, has been in response 
to the enormous expense associated with maintaining them in 
Japan; but it is also a statement about the effectiveness of a 
large percentage of these people, who typically possess no 
Japanese language skills or background. Nevertheless, the 
necessity to do business in Japan is clear to most major United 
States companies, and access to Japan's inside information is 
critical to the Success of Such companies. 
The situation in Japanese universities is also discouraging. 

There are currently about 30,000 foreign students in Japanese 
universities, compared to a total of over 300,000 foreign 
students studying in the United States. Ninety percent of the 
foreign students in Japan are from Asia, while there are less 
than 1,000 students in Japan from the United States. The cost 
of living and housing again contribute greatly to this disparity, 
but the language barrier must be seen as the prime hurdle that 
causes students to abandon the attempt to explore Japan. In 
the future, the desirability for students and researchers to 
work in Japan should increase due to the growth of “science 
cities' and the increase in the hiring of foreign researchers by 
Japanese corporations. The burden of studying Japanese, 
however, remains. 

In total there are over 60,000 people enrolled in Japanese 
language programs in Japan; and according to the Japan 
Foundation, there are approximately 1,000,000 Japanese lan 
guage students worldwide, with a total of over 8.200 Japanese 
language instructors in 4,000 institutes. However, without a 
more effective and productive methodology for reading Japa 
nese and for building Japanese language Vocabulary, the level 
and breadth of the information making its way to non-natives 
should not be expected to improve. 
The foregoing is but one example of the many difficulties 

one is faced with when acquiring or using difficult or unfa 
miliar material. The first challenge anyone reading a difficult 
text, is faced with is the issue of character recognition and 
pronunciation. For example, a student of the Japanese lan 
guage spends many frustrating hours counting character 
strokes and looking up characters in a dictionary. Challenges 
Such as this are the primary reason so many people give up on 
Japanese after a short trial period. It is also the reason that 
people who continue to pursue the language are unable to 
build an effective vocabulary. 
Knowing the 'yomi' or pronunciation or reading of a word 

is essential to memorize and assimilate the word into one's 
vocabulary. This allows the student to read a word in context 
and often times deduce its meaning. But in many cases, the 
word may be entirely new to the reader, or it may be a usage 
that the reader has never seen. Looking up the word in the 
dictionary or asking a native speaker are the only options 
available to a student. Once the yomi for the word is known, 
i.e. the meaning and understanding of the word in context, the 
final challenge is to memorize the word and make it a part of 
a usable Vocabulary. 
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The sheer number of characters in ideographic alphabets, 
Such as Kanji, presents unique challenges for specifying and 
identifying individual characters. 

Various schemes have been proposed and descriptions can 
be found in the literature for the entry of Kanji characters into 
computers and the like. 

See, for example, Y. Chu, Chinese/Kanji Text and Data 
Processing, IEEE Computer (January 1985); J. Becker, Typ 
ing Chinese, Japanese, and Korean, IEEE Computer (January 
1985); R. Matsuda, Processing Information in Japanese, 
IEEE Computer (January 1985); R. Walters, Design of a 
Bitmapped Multilingual Workstation, IEEE Computer (Feb 
ruary 1990); and J. Huang. The Input and Output of Chinese 
and Japanese Characters, IEEE Computer (January 1985). 

And, see J. Monroe, S. Roberts, T. Knoche, Method and 
Apparatus for Processing Ideographic Characters, U.S. Pat. 
No. 4,829,583 (9 May 1989), in which a specific sequence of 
strokes is entered into a 9x9 matrix, referred to as a training 
square. This sequence is matched to a set of possible corre 
sponding ideographs. Because the matrix senses stroke start 
ing point and stroke sequences based on the correct writing of 
the ideograph to be identified, this system cannot be used 
effectively until one has mastered the writing of the ideo 
graphic script. See, also G. Kostopoulos, Composite Charac 
ter Generator, U.S. Pat. No. 4,670.841 (2 Jun. 1987); A. 
Carmon, Method and Apparatus For Selecting, Storing and 
Displaying Chinese Script Characters, U.S. Pat. No. 4.937, 
745 (26 Jun. 1990); and R. Thomas, H. Stohr, Symbol Defi 
nition Apparatus, U.S. Pat. No. 5,187,480 (16 Feb. 1993). 
A text revision system is disclosed in R. Sakai, N. Kitajima, 

C. Oshima, Document Revising System For Use With Docu 
ment Reading and Translation System, U.S. Pat. No. 5.222, 
160 (22 Jun. 1993), in which a foreigner having little knowl 
edge of Japanese can revise misrecognized imaged characters 
during translation of the document from Japanese to another 
language. However, the system is provided for commercial 
translation services and not intended to educate a user in the 
understanding or meaning of the text. 

Thus, although much attention has been paid, for example, 
to the writing, identification, and manipulation of ideographic 
characters, none of these approaches are concerned with pro 
viding a language learning system. The state of the art for 
ideographic languages, such as Japanese, does not provide an 
approach to learning the language that meets the four primary 
challenges discussed above, i.e. reading the language (for 
example, where an ideographic alphabet is used), compre 
hending the meaning of a particular word encountered while 
reading the language, understanding the true meaning of the 
word within the context that the word is used, and including 
the word in a personal dictionary to promote long term reten 
tion of the meaning of the word. A system that applies this 
approach to learning a language would be a significant 
advance in bridging the gap between the world's diverse 
cultures because of the increased understanding that would 
result from an improved ability to communicate with one 
another. Such system would only be truly useful if it were 
based upon an indexing scheme that allowed meaningful 
manipulation and display of the various elements of the lan 
gllage. 

SUMMARY OF THE INVENTION 

The invention provides a unique system for indexing dis 
played elements and finds ready application, for example in a 
language learning system that enhances and improves the 
way non-natives read foreign languages, for example the way 
a native English speaker reads Japanese. The language learn 
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4 
ing system provides a more effective way for people to read 
and improve their command of the foreign language, while at 
the same time communicating insightful and relevant cul 
tural, Social, and economic information about the country. 
The learning model used by the language learning system 

is straightforward and is based upon methods that are familiar 
to most learners of foreign languages. The system addresses 
the four challenges of reading a foreign language, such as 
Japanese: i.e. reading the foreign word or character, such as 
Kanji in the case of a language having an ideographic alpha 
bet. Such as Japanese; comprehending the meaning of the 
word; understanding the word in context; and including the 
word in a personal Vocabulary. 
The exemplary embodiment of the invention includes one 

or more foreign language books that are read on an electronic 
display of a personal computer. English word references are 
available for each word in such books. The definitions of such 
words are derived from well known foreign language dictio 
naries. With regard to the Japanese language, the system saves 
significant amounts of time and effort by eliminating the need 
for the user to look up Japanese characters in a Kanji dictio 
nary. 
When one uses the system, the pronunciations or readings 

(yomi) for all words are immediately viewable in a pop-up 
window without accessing a disk based database, for example 
by clicking a mouse on a selected word or phrase. In the same 
pop-up window, the system provides an English reference to 
any word that is also selected by clicking on the selected word 
or phrase. The system provides extensive notes for difficult 
phrases and words not normally found in a dictionary, and 
includes a relational database designed for managing and 
studying words. This allows a user to build a personal data 
base of words that he would like to master. Words may also be 
entered from other sources that are currently in paperor other 
electronic formats. A unique indexing scheme allows word 
by-word access to any of several external multi-media refer 
CCCS, 

BRIEF DESCRIPTION OF THE DRAWINGS 

FIG. 1 is a block schematic diagram of a language learning 
system according to the invention; 

FIG. 2 is a flow diagram in which the mechanism for 
indexing and linking text to external references is shown 
according to the invention; 

FIG. 3 is a screen display showing a highlighted Japanese 
word and a pop-up menu, including an English reference to 
the Japanese word, according to the invention; 

FIG. 4 is a screen display showing a highlighted Japanese 
word and a pop-up menu, including Japanese language anno 
tations of the Japanese word, according to the invention; and 

FIG.5 is a screen display showing a Japanese word listed in 
a personal dictionary, as well as a word control palette, 
according to the invention. 

DETAILED DESCRIPTION OF THE INVENTION 

The invention provides a system that is designed to 
enhance and improve the way one reads or learns to read a 
difficult text, such as a foreign language, especially a lan 
guage based upon an ideographic alphabet, Such as Kanji 
which is used in the Japanese language. The text may be any 
ofactual textbased material, or audio, video, or graphic based 
information. In the language learning application, the system 
is modeled on the process by which the foreign language is 
read and addresses the problems most persons face when 
reading a language that is different from their own. 
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The exemplary embodiment of the invention is based upon 
two powerful functional modules that provide a comprehen 
sive approach to reading and learning a foreign language, 
Such as Japanese. The first module is an electronic viewer that 
gives the user access to reference information on each word in 
the electronic text at a word by word level. The second mod 
ule is a relational database that allows a user to create word 
lists with practically no limit in size. The two modules are 
integrated to provide the user with everything needed to read 
the foreign language quickly and enjoyably, as well as to build 
their own individual vocabulary. 

FIG. 1 is a block schematic diagram of an exemplary 
embodiment of the invention that implements a language 
learning system. An electronic book and/or a multi-media 
Source material is provided as a teaching resource. A text file 
10 and/or a multimedia source 14, consisting of an audio/ 
video file 11 and synchronized text 13, which may include 
Sound, images, and/or video is edited during construction of a 
linked text database by a visual editor 19 that used to build a 
wordified database 20. The database 20 sources a grammar 
parser 23 and a link engine 22 that builds an index 21 which, 
in turn, locates each textual and audio/video reference in the 
source material. The index provides a location for each ref 
erence in a database 12 that includes a relational database 
engine 15, and linkable entities, such as text references 16, 
audio references 17, graphic references 18, and the like. 
The link engine 22 outputs the selected text to a word list 28 

derived from the input text file 10 and/or audio/video infor 
mation 14, and also outputs the reference information 24. 
consisting of linkable entities 25, 26, 27, which are derived 
from the indexed database 12. The indexor/viewer 29 creates 
a multi-media resource 30, such as a file 33 that was processed 
as described above to produce a data resource 34, an offset 
index 35, and linked entities 36 to the data resource for access 
by the user. 
A user interface 32 to the system includes an electronic 

viewer 43 that runs along with the system application pro 
gram 42 and provides the following functional elements: 
index management 37, user display 38, a table of contents 39, 
a pop-up display 40, and a personal dictionary 41. 
The electronic viewer module is used to view and read the 

electronic books provided with the language learning system. 
The module includes the following features: 
1. One-click, pop-up information for all words containing 

foreign language words; 
2. A word display palette; 
3. A contents menu for each book; 
4. Search functions; 
5. Selectable browse and edit modes; and 
6. The ability to copy words and associated information into 

personal dictionary. 
The personal dictionary is a relational database that is 

optimized to manage and study words. Unlike electronic dic 
tionaries, where only the word entries of the dictionary are 
searchable, the personal dictionary of the system herein 
allows one to search on each of eight or more keys associated 
with a word. 

The following functions are supported by the personal 
dictionary: 
1. Display of words in an easy to read, easy to access format; 
2. Full relational database capabilities for the following: the 

word, the pronunciation, English reference, notes, cat 
egory, source, priority, and review date; 

. Search capabilities for any item; 

. Capabilities to store an unlimited number of words: 

. A flash word feature to allow self-testing in sorted or 
random order, and 
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6 
6. Capabilities to review words sorted by any word key. 
The personal dictionary also allows the user to enter words 

from other sources that are currently in paper or other elec 
tronic formats. For example, a user can copy all the words that 
they have in paper format from study lists and notes. With this 
feature, a student can have all of his study materials in one 
easy to access database. Users can also import and export data 
in a text format Supported by standard word processor and 
spreadsheet programs. 
The exemplary personal dictionary includes a base 500 

word Vocabulary list designed for the beginning student. A 
variety of words are included related to Such general topics as: 
foods and drink, family, health, the body, commuting and 
transportation, environment, economics, finance, politics, 
companies, industries, computers, sports, and the language 
itself. 
The system includes one or more electronic books. The 

words in each book is fully Supported with readings, English 
references, and hypernotes. In the exemplary embodiment of 
the invention there are typically over 10,000 words, as well as 
over 1,000 notes presented in an easy to read, easy to memo 
rize format. 
The English reference feature of the system provides basic 

information to help users understand the word in its context. 
For each word, a generalized definition of the word is pro 
vided. The pop-up fields are used to give the user a quick 
reference to the word and to allow the user to continue reading 
or reviewing the text. 

Current electronic book formats provide simple hyperlinks 
in what is termed hypertext or multimedia. Hyperlinks to date 
have been simple pointers that directly link text with other 
text, graphics, or sound within the textfile itself. For reference 
materials, such as electronic encyclopedias, and dictionaries, 
hyperlinks provide a quick and easy way to find related mate 
rial to a topic or subject. However, these links must be hard 
coded and are therefore cumbersome to author. The format of 
the system herein described provides a new means of relating 
text, pictures, and/or video with information to enrich and 
expand the impact of every elementina text, picture, or video. 
This format differs from current electronic books which only 
link text with other parts of text or content. 

In the new format of the present system, every word or 
Sound, for example, can be linked to information not con 
tained within the text using an indexing method that maps a 
single word or phrase to a table that contains external refer 
ence material. This reference can be in the form or of text, 
graphics, images, movies, and/or sound. Thus, the resource 
materials, such as the text, remains unaltered and therefore 
compact in terms of file size. Thus, the resource materials, for 
example the text, takes up less disk space and runs faster. 

FIG. 2 is a flow diagram in which the mechanism for 
indexing and linking text to external references is shown 
according to the invention. To find a reference to a particular 
word or other selected entry displayed on the screen, the user 
clicks the text that is viewed with a pointing device. Such as a 
mouse (200). The click position is determined and used to 
calculate an offset value within the text (200). In the example 
shown in FIG. 2, the user clicks at a particular location, e.g. 
horizontal and vertical coordinates 100 and 75, respectively, 
and an offset value of 25 is returned. The offset value is 
compared to the start and end position indices stored in a 
look-up table (201, 202). The link between the selected text 
and the external reference is resolved (203), and the external 
reference is retrieved and displayed to the user (204). In the 
example of FIG. 2 an offset of 25 is located at the look-up 
table location having a start point of 20 and an endpoint of 27 
and is linked to text located at position 200. As can be seen 
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from the look-up table (202), the link may be to text, sound, 
pictures, and video. In the example, the text linkage is to the 
English language word “Japanese economy'. 
The actual indexing process is completed in several steps, 

including word cuts, linking, and compilation. 
Word Cuts 
The word cutting process is accomplished using a simple 

visual editor, for example a point and click system using a 
pointing device. Such as a mouse. The process divides the text 
into the individual components of text that are linked with the 
additional reference material. The original text is provided by 
a publisher in electronic form in a raw binary text format (e.g. 
an ASCII text file or other word processor file). This text is 
then divided up into the component word or phrases in prepa 
ration for the next step. 
Linking 
The linking process takes the text after the word cut process 

and links it to an external reference. The database 20 sources 
a grammar parser 23 and a link engine 22 that builds an index 
21 which, in turn, locates each textual and audio/video refer 
ence in the source material. In the case of language learning, 
the component words and phrases are linked to a foreign 
language dictionary. In other cases, links may be made to 
other reference materials, such as graphics and/or sound. 
Compilation 

After linking, the text and references are compiled. During 
compilation, the cut text is reassembled to create an image of 
the text that the end user sees. At this point additional format 
ting may be applied to the text for final display. Indices of the 
component words and phrases are built with links to the 
reference material and duplicate references are consolidated 
to conserve memory and storage requirements. 
A key feature of the system format is the method by which 

the original book text is indexed and linked with the external 
references. During the compile process an image of the text is 
created. When the image is created, the cuts are indexed based 
upon the position offset from the beginning of the text. The 
start and end points of the cut text are recorded in a look-up 
table along with the links to external references. The number 
and type of links for any component is dynamic. This means 
that a single entry could have several different references 
attached to it, each containing different forms of data. 
The user interacts with the electronic book using a pointing 

device. When the user "clicks' within the text image, the 
location of the pointer is determined. The location is con 
verted into a position offset from the beginning of the text and 
used to determine which component word or phrase was 
selected. The process involves comparing the offset with the 
start and end values stored in the look-up table as discussed 
above in connection with FIG. 2. When the offset value falls 
between a component's start and endpoints, a match is made 
and the external references can be resolved. 
English Reference 

FIG. 3 is a screen display showing a highlighted Japanese 
word and a pop-up menu, including a translation of the Japa 
nese word, according to the invention. The following section 
explains the English reference pop-ups associated with each 
word: 

The English reference is intended to give the user basic 
information to help him understand a selected word in its 
context. A majority of the word definitions found in the 
English reference are not the direct translation of the word in 
that particular context. They are mostly generalized defini 
tions of the given word. These pop-up fields give the user a 
quick reference to the word and allow him to continue reading 
or reviewing the text without the need to stop and access a 
dictionary. In applying the invention to other languages, for 
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8 
example Korean or Chinese, or to difficult materials. Such as 
highly technical or complex matters, appropriate external 
references should be selected. 

In the exemplary embodiment of the invention, a priority is 
placed on making the text readable, rather than on creating a 
detailed grammatical description of it. The English reference 
is not considered a direct translation of the foreign language, 
but rather is preferably a contextual definition based upon the 
words meaning within the text. 
Definitions 

Definitions in dictionaries are written for practical use. 
Accordingly, word and sentence translations are preferably 
written in modern English at a level acceptable to native 
speakers. The types of phrases and words covered by the 
English reference are preferably of great variety. The English 
translation should therefore be highly readable and useful. 
Hyper Notes 

FIG. 4 is a screen display showing a highlighted Japanese 
word and a pop-up menu, including Japanese language anno 
tations of the Japanese word, according to the invention. 

Hyper notes are provided for a great number of words and 
phrases included in the system. Most of the explanations are 
grammatical in nature, but others simply explain the passage 
in further depth or rephrase the foreign language word or 
phrase in simpler language. The notes have been written in the 
foreign language because it is believed that this is the best way 
for students of the language to improve their skills. As in the 
main text, the yomi and meanings of the words are given in a 
pop-up form. 
Using the Electronic Viewer Module 
The electronic viewer module provides the following pull 

down menus: File, Edit, Words, View. 
The File Menu includes: 

. Open (opens up a book for reading); 

. Close (closes a book); 

. Personal Dictionary (opens the personal dictionary); 

. Import Words (imports a tab delineated file into the per 
Sonal dictionary); 

. Export Words (exports a tab delineated file into the per 
Sonal dictionary); and Quit (quits the applications). 
The Edit Menu Includes: 

1. Undo (undoes a previously deleted entry in the personal 
dictionary fields); 

2. Cut (cuts a highlighted block of text in the personal dictio 
nary fields); 

3. Copy (copies the selected text into the clipboard in either 
the electronic viewer module or the personal dictionary); 
and 

4. Paste (pastes the copied text into the target field in the 
personal dictionary). 
The Words Menu includes: 

1. Find (displays the search dialogue box): 
2. Find Next (finds the next entry using the previously entered 

search word); 
3. Next (goes to the next word in the personal dictionary based 

on the current sort setting); 
4. Prey (goes to the previous word in the personal dictionary 

based on the current sort setting); 
5. Jump to Text (jumps from the personal dictionary to the 

Source of the word in the original text); and 
6. Flash Words (displays the words in the personal dictionary 

in slide show fashion). 
The View Menu includes: 

1. Browse (sets the program to Browse Mode, indicated by the 
arrow cursor): 

2. Edit (sets the program to Edit Mode, indicated by the 
I-beam cursor); 

i 
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3. Show Note Guides (displays the location of the Notes in the 
text of the viewer); 

4. Show Notes (displays the Notes field in the personal dic 
tionary); 

5. Show Info (displays the Word Information and sort control 
button in the personal dictionary); and 

6. Show Palette (displays the Word Display Palette with the 
electronic viewer module). 
After a study session starts, a Table of Contents for the 

selected book appears. By clicking on any item, the user is 
able to go to the desired section of the book. The selected 
chapter appears as a normal text file. The electronic viewer 
window has a display region with a button to display the Table 
of Contents. The current chapter name of the selected book is 
also displayed in this area. To select a word or phrase in the 
book, the user clicks on a word that is not understood and a 
pop-up menu immediately appears (see FIG. 3). The pop-up 
information contains the yomi, the English reference, and the 
notes selection. If the pop-up menu does not appear, the 
selected word is not referenced. Theyomialso appears in the 
pop-up menu. 

To view the English reference information the user selects 
the English Reference from the pop-up menu and the infor 
mation appears next to the pop-up menu. 

To see the Note associated with the text, the user selects 
Notes from the pop-up menu and the Note appears in a sepa 
rate window. If the Notes item is gray (for example, as shown 
in FIG. 3), no Note is available for the word. Notes also 
include a pop-up reference feature. The first word in the text 
with reference information has a black underbar beneath it. 
This is the Word Pointer, which indicates the most recent 
location for the pop-up menu and defaults to the first word. To 
see where a Note begins and ends, the user selects Show Note 
Guides from the View Menu. 
The electronic viewer module also provides a Palette. To 

display the palette, the user selects Show Palette from the 
View Menu. The Word Display Palette displays all the refer 
ence information for quick viewing. The arrow buttons move 
the location of the Word Pointer and update the reference 
information. The See Note command displays the Note if one 
exists for the word and is gray if one is not present. The Add 
to PD command automatically copies the word and its asso 
ciated information to the personal dictionary. If a Note is 
present, it is also copied to the personal dictionary. 
A limited amount of text can be copied from the book by 

selecting Edit Mode from the View Menu, highlighting the 
desired text, and selecting Copy from the Edit Menu. Words 
can be searched for in the book by selecting Find from the 
Words Menu. 
Using the Personal Dictionary Module 

FIG.5 is a screen display showing a Japanese word listed in 
a personal dictionary, as well as a personal dictionary control 
panel, according to the invention. The personal dictionary 
module in the exemplary embodiment of the invention is 
implemented in a relational database that is optimized for 
managing and studying words. Unlike electronic dictionaries 
where only the word entries of the dictionary are searchable, 
the personal dictionary module allows a user to search on 
each of the eight or more keys associated with a word, as 
discussed above. To open the personal dictionary, the user 
selects Personal Dictionary from the File menu or double 
clicks on a Personal Dictionary icon. 
The words contained in the personal dictionary are dis 

played in large fields with the word on the bottom, the yomi 
above the word, and the English reference on top, as shown in 
FIG. 5. In Browse Mode, clicking on a word alternately hides 
and shows the word. This function is used to enhance review 

10 

15 

25 

30 

35 

40 

45 

50 

55 

60 

65 

10 
and study of the Main Control Buttons. The Main Control 
Buttons are located just below the Word field. The arrow keys 
display the next or previous words based on the sort key 
indicated by the Sort Button in the bottom left corner. The 
Show Notes button displays the Note information about the 
Word. This button toggles to Hide Notes when the field is 
displayed and Show Notes when hidden. Additional notes and 
annotations can be entered directly. The Quick Search button 
displays the word in a pop-window for quick Search of a 
single character. After the pop-up is displayed, the user can 
click on the desired character to search. The Flash Words 
button displays the words in the personal dictionary in slide 
show fashion. Sort order or random order are selectable: sort 
order uses the current sort order. 
The Find button displays the search dialogue window. 

Words are searchable by the following keys: Word, Yomi, 
English Reference, Category, Source, Priority, or Date. The 
personal dictionary supports logical “AND” searching for 
each of the above keys. The following features are supported: 
1. Jump to Text—this button jumps control and display from 

the personal dictionary to the source of the word in the 
original text; 

2. Show Info this button displays the Word Information 
Buttons, as well as the Date Indicator; this button toggles to 
Hide Info when displayed, and Show Info when hidden; 
and 

3. Word Information—this button appears on the bottom of 
the screen and has the following functions: 
a. Current Sort—sets the sort order for the Dictionary to 

either Category, Source, Priority, or Date: 
b. Category—provides for a set of predefined Categories 

for words as well as the ability to add new Categories: 
c. Source indicates the source of the Word: user entered 

words are indicated by the user name or if not available, 
by the default User: 

d. Priority—allows the user to assign a priority to a word 
from 1 to 5; and 

e. Date Display—the date is displayed in the bottom right 
hand corner; the date is automatically updated each time 
the word is displayed. 

Searching 
Both the electronic viewer module and the personal dictio 

nary module provide search features accessible via the Word 
Menu. After selecting Find from the menu, the search dia 
logue appears. 
The electronic viewer module includes a simple search 

feature that allows the user to search for a string of text 
anywhere in the book. The user enters the desired text and 
clicks Find to execute the Search. Find Next searches for the 
next occurrence of the word in the text. 

In the personal dictionary, a slightly more complex search 
feature is provided. The search dialogue allows the user to 
enter multiple search terms. For example, a user can search 
for a certain term in the Economics category or the user can 
look for a Kanji that has a certain reading. More search terms 
result in increased search time. The search term for Word, 
Yomi, Reference, Note, and Source are indexed based on the 
first seven characters contained in the field. Characters 
appearing after the seventh character in any of these fields are 
not found with the Starts With selection. Selecting Con 
tains searches the entire text in the field. 
To search, the user enters the desired word or character and 

then selects Starts With or “Contains from the menu. A 
Starts With search is the fastest. The Category search terms 
are based on the category list. The integers 1 to 5 can be 
entered for Priority. Date searching can be performed as ‘is’, 
is before, or is after. After entering the desired search 
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information, the user clicks Find to execute the Search. Find 
Next searches for the next occurrence in the personal dictio 
nary. 
Importing/Exporting Word Lists 

Text files can be read into the personal dictionary to make 
data exchange with other programs and colleagues feasible. 
The following format should be followed to allow accurate 
importing. One may use a spreadsheet program to build the 
word table and export the information as a tab delimited file. 
If a word processor is used, the user must add an extra tab for 
blank fields and follow the format listed below. In the exem 
plary embodiment of the invention, Export and Import uses 
the following format: 

Word (TAB); 
Pronunciation TAB}: 
Meaning (TAB); 
Notes (TAB); 
Category (TAB); 
Source (TAB); 
Priority TAB); and 
Date Hard Return). 

Setting up the Word field as column A in a spreadsheet and 
then exporting as a text file results in this format. If a word 
processor is used, one should also save as a text file. One 
should not include any hard returns (user entered returns) 
within the string of text for the given word. If given the option, 
the user should elect to have soft returns (automatically 
entered returns) deleted. To import, the user selects Import 
Words from the File Menu, and then chooses the file for 
import. To export, the user selects Export Words from the File 
Menu, and then enters a name for the given file. 

Although the invention is described herein with reference 
to the preferred embodiment, one skilled in the art will readily 
appreciate that other applications may be substituted for those 
set forth herein without departing from the spirit and scope of 
the present invention. For example, the invention may be used 
to index images such that elements of the image are linked to 
an external reference. Thus, an illustration of the human body 
may include descriptive external resources for each of the 
body's internal organs, and would thereby aid in the study of 
anatomy. Likewise, a video or other moving picture display, 
for example animated displays, could be indexed such that the 
picture could be stopped and various elements within a frame 
of the picture could be examined through links to external 
references. The invention allows such application because it 
does not embed information within the Source material as is 
the case with prior art hyperlink technology. Rather, the 
invention creates a physical counterpart to the image in which 
a selected image position defines an offset that locates a 
desired external reference. Accordingly, the invention should 
only be limited by the claims included below. 

We claim: 
1. A system for linking source material to reference mate 

rial for display comprising: 
a source material image including a plurality of discrete 

pieces having links to external reference materials com 
prising any of textual, audio, video, and picture infor 
mation, said source material image stored in an elec 
tronic database; 

means for determining an address on said electronic data 
base for the beginning position of said source material 
image; 

means for cutting said source material image into said 
discrete pieces; 
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12 
means for determining an address on said electronic data 

base for a start point and an end point of said discrete 
pieces of said image based upon said beginning position 
of said source material image; 

means for recording said start and said endpoint addresses 
in a look-up table; 

means for selecting a discrete portion of said source mate 
rial image: 

means for determining the address on said electronic data 
base of said selected discrete portion: 

means for converting said address of said selected discrete 
portion to an offset value from said beginning position 
address of said source material image: 

means for comparing said offset value with said recorded 
start and end point addresses of said discrete pieces in 
said look-up table; 

means for selecting an external reference that corresponds 
to said look-up table start and end point addresses; and 

means for reproducing said external reference. 
2. The system of claim 1, further comprising: 
a linking engine for linking said source material to said 

reference information on any of a word-by-word and 
phrase-by-phrase basis. 

3. The system of claim 2, said linking engine further 
comprising: 
word cut means for dividing said source material into dis 

crete pieces; 
linking means for establishing at least one link between 

each of said discrete pieces and said reference informa 
tion; 

compiler means for assembling an integrated source image 
from said discrete pieces: 

indexing means for linking said assembled discrete pieces 
to said reference information. 

4. The system of claim 3, said linking engine further 
comprising: 
means for building an index to link each of said source 

material pieces to said reference information. 
5. The system of claim 4, wherein said index links said 

Source material pieces to said reference information based 
upon the value of the offset of the starting and ending position 
addresses of said source material pieces from the beginning 
position address of said integrated source image. 

6. The system of claim 5, wherein said offset locates said 
reference information to a corresponding source material 
piece based upon offset occurrence within a range defined by 
the value of the offsets of the starting and ending point 
addresses of said source material pieces from said beginning 
position address of said integrated source image. 

7. The system of claim 1, further comprising: 
means for manipulating said stored source material and 

reference information with at least two user keys. 
8. A method for linking source material to reference mate 

rial for display, comprising: 
determining the beginning position address of a source 

material image stored in an electronic database, said 
Source material image including a plurality of discrete 
pieces having links to external reference materials com 
prising any of textual, audio, video, and picture infor 
mation; 

cutting said source material image into said discrete pieces; 
determining a starting point address and an ending point 

address of said discrete pieces of said image based upon 
said beginning position address of said source material 
image; 

recording said starting and said ending addresses in a look 
up table; 
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Selecting a discrete portion of said source material image: 
determining the address of said selected discrete portion; 
converting said address of said selected discrete portion to 

an offset value from said beginning position address of 
said source material image: 

comparing said offset value with said recorded start and 
end point addresses of said discrete pieces in said look 
up table; 

Selecting an external reference that corresponds to said 
look-up table start and end point addresses; and 

reproducing said external reference. 
9. In a language learning method, a method for linking 

Source material to reference material for display, comprising 
the steps of: 

reading a foreign language source material image includ 
ing a plurality of discrete pieces having links to external 
reference materials comprising any of textual, audio, 
Video, and picture information with an electronic 
viewer; 

accessing reference materials on selected portions of said 
Source material image; 

determining the beginning position address of said source 
material image; 

cutting said source material image into said discrete pieces; 
determining a start point address and an end point address 

of said discrete pieces of said image based upon said 
beginning position address of said source material 
image; 

recording said start and said end point addresses in a look 
up table; 

Selecting a discrete portion of said source material image: 
determining the address of said selected discrete portion; 
converting said address of said selected discrete portion to 

an offset value from said beginning position address of 
said source material image: 

comparing said offset value with said recorded start and 
end point addresses of said discrete pieces in said look 
up table; 

Selecting an external reference that corresponds to said 
look-up table start and end point addresses; and 

reproducing said external reference. 
10. The method of claim 9, further comprising the step of: 
linking said source material to said reference information 

with a linking engine on any of a word-by-word and 
phrase-by-phrase basis. 

11. The method of claim 10, said linking step further 
comprising the steps of 

dividing said source material into discrete pieces; 
establishing at least one link between each of said discrete 

pieces and said reference information; 
assembling an integrated source image from said discrete 

pieces; and 
linking said assembled discrete pieces to said reference 

information. 
12. The method of claim 11, said linking step further 

comprising the step of 
building an index to link each of said source material pieces 

to said reference information. 
13. The method of claim 12, wherein said index links said 

Source material pieces to said reference information based 
upon the offset between the starting position address for said 
Source material pieces and the beginning position address of 
said integrated source image. 

14. The method of claim 13, wherein said offset locates 
said reference information to a corresponding source material 
piece based upon offset occurrence within a range defined by 
the value of the offsets of the starting and ending position 
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14 
addresses of said source material pieces from said beginning 
position address of said integrated source image. 

15. In a language learning system, a system for linking 
Source material to reference material for display, comprising: 

a text image including a plurality of discrete pieces having 
links to external reference materials comprising any of 
textual, audio, video, and picture information; 

means for determining the beginning position address of 
said text image: 

means for cutting said text image into said discrete pieces; 
means for determining a starting point address and an 

ending point address of said discrete pieces of said 
image based upon said beginning position address of 
said source material image: 

means for recording said starting and said ending point 
addresses in a look-up table; 

means for selecting a discrete portion of said text image: 
means for determining the address of said selected discrete 

portion; 
means for converting said address of said selected discrete 

portion to an offset value from said beginning position 
address of said source material image: 

means for comparing said offset value with said recorded 
start and end point addresses of said discrete pieces in 
said look-up table; 

means for selecting an external reference that corresponds 
to said look-up table start and end point addresses; and 

means for displaying said external reference. 
16. In a language learning method, a method for linking 

Source material to reference material for display, comprising 
the steps of: 

determining the beginning position address of a text image, 
said text image including a plurality of discrete pieces 
having links to external reference materials comprising 
any of textual, audio, video, and picture information; 

cutting said source material image into said discrete pieces; 
determining a starting point address and an ending point 

address of said discrete pieces of said image based upon 
said beginning position address of said text image: 

recording said starting and said ending point addresses in a 
look-up table; 

selecting a discrete portion of said text image: 
determining the address of said selected discrete portion; 
converting said address of said selected discrete portion to 

an offset value from said beginning position of said text 
image; 

comparing said offset value with said recorded start and 
end point addresses of said discrete pieces in said look 
up table; 

selecting an external reference that corresponds to said 
look-up table start and end point address; and 

displaying said external reference. 
17. A method for linking source material to external refer 

ence materials for display, the method comprising the steps 
of: 

determining a beginning position address of a source mate 
rial stored in an electronic database, 

cutting the source material into a plurality of discrete 
pieces, 

determining a starting point address and an ending point 
address of at least One of the plurality of discrete pieces 
based upon the beginning position address, 

recording in a look up table the starting and ending point 
addresses, 

linking at least one of the plurality of discrete pieces to at 
least one of a plurality of external reference materials, 
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the plurality of external reference materials comprising 
any of textual, audio, video, and picture information, 

selecting a discrete portion of an image of the source 
material; 

determining a display address of the selected discrete por- 5 
tion of the source material image, 

converting the display address of the selected discrete por 
tion to an offset value from the beginning position 
address, 

comparing the offset value with the starting and ending 10 
point addresses recorded in the look-up table to identifi 
one of the plurality of discrete pieces, 

selecting one of the plurality of external reference materi 
als corresponding to the identified one of the plurality of 
discrete pieces, and 

displaying the selected one of the plurality of external 
reference materials. 

18. The method of claim 17, wherein cutting the source 
material into a plurality of discrete pieces is done manually. 

19. The method of claim 17, wherein cutting the source 
material into a plurality of discrete pieces is done automati 
cally. 

20. The method of claim 19, wherein automatically cutting 
the source material into a plurality of discrete pieces is done 
using a grammar parser. 

21. The method of claim 19, wherein automatically cutting 
the source material into a plurality of discrete pieces is done 
without using tags. 

22. The method of claim 19, wherein automatically cutting 
the source material into a plurality of discrete pieces is done 
without reference to any tags which may be located in the 
source material. 

23. The method of claim 17, wherein the link is a hyperlink. 
24. The method of claim 17, wherein the link is an address 

of the selected one of the plurality of external reference mate 
rials. 

25. The method of claim 17, wherein the link is reference 
information for retrieving the selected one of the plurality of 
external reference materials. 

26. The method of claim 17, wherein the source material is 40 
text based source material. 

27. The method of claim 17, wherein the source material is 
image based source material. 

28. The method of claim 17, wherein the source material is 
graphic based source material. 

29. The method of claim 17, wherein the source material is 
audio based source material. 

30. The method of claim 17, wherein the source material is 
video based source material. 

31. The method of claim 17, wherein the source material is 
a combination of two or more of text based source material, 
image based source material, graphic based source material, 
audio based source material, and video based source mate 
rial. 

32. The method of claim 17, wherein linking at least one of 55 
the plurality of discrete pieces is done manually. 

33. The method of claim 17, wherein linking at least one of 
the plurality of discrete pieces is done automatically. 

34. A system for linking source material to external refer 
ence materials for display, the system comprising: 

means for determining a beginning position address of a 
source material stored in an electronic database, 

15 

25 

30 

35 

45 

50 

60 

16 
means for cutting the source material into a plurality of 

discrete pieces, 
means for determining a starting point address and an 

ending point address of at least one of the plurality of 
discrete pieces based upon the beginning position 
address, 

means for recording in a look up table the starting and 
ending point addresses, 

means for linking at least One of the plurality of discrete 
pieces to at least one of a plurality of external reference 
materials, the plurality of external reference materials 
comprising any of textual, audio, video, and picture 
information, 

means for selecting a discrete portion of an image of the 
source material 

means for determining a display address of the selected 
discrete portion of the source material image, 

means for converting the display address of the selected 
discrete portion to an offset value from the beginning 
position address, 

means for comparing the offset value with the starting and 
ending point addresses recorded in the look-up table to 
identif one of the plurality of discrete pieces, 

means for selecting one of the plurality of external refer 
ence materials corresponding to the identified one of the 
plurality of discrete pieces, and 

means for displaying the selected one of the plurality of 
external reference materials. 

35. A method for linking textual source material to external 
reference materials for display, the method comprising the 
steps of 

determining a beginning position address of textual source 
material stored in an electronic database, 

cutting the textual source material into a plurality of dis 
Crete pieces, 

determining a starting point address and an ending point 
address of at least one of the plurality of discrete pieces 
based upon the beginning position address, 

recording in a look up table the starting and ending point 
addresses, 

linking at least one of the plurality of discrete pieces to at 
least one of a plurality of external reference materials, 
the plurality of external reference materials comprising 
any of textual, audio, video, and picture information, 

selecting a discrete portion of an image of the textual 
source material 

determining a display address of the selected discrete por 
tion of the textual source material image, 

converting the display address of the selected discrete por 
tion to an offset value from the beginning position 
address, 

comparing the offset value with the starting and ending 
point addresses recorded in the look-up table to identifi 
one of the plurality of discrete pieces, 

selecting one of the plurality of external reference materi 
als corresponding to the identified one of the plurality of 
discrete pieces, and 

displaying the selected one of the plurality of external 
reference materials. 


